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1. S&M Overview  
 

S&M1 aims at selecting sets of earthquake ground motions (EGMs) approaching a target spectrum, 

consisting either of unscaled records or of spectrally matched accelerograms. S&M takes advantage of a 

two datasets of worldwide records (SIMBAD and NGAWest2) along with a set of simulated ground motions 

(BB-SPEEDset). SIMBAD database includes intermediate to large magnitude earthquakes (from 5 to 7+) at 

short epicentral distances (mostly Repi < 30 km). In this way, all records are expected to be usable for 

engineering applications, with limited or no scaling factors. If required, scaling is iteratively performed in 

the frequency domain, until the response spectrum approaches the target one within a prescribed 

tolerance. 

The selection and matching procedure is fast, flexible and may be easily adapted to the specific needs of 

the User. In case spectral matching is required, the selection may be suitably guided by weights in order for 

the selected records to approach closely the long period portion of the spectrum, so that the subsequent 

scaling provides only minor modifications to the physically constrained low-frequency portion of EGM. 

Tolerance of spectral matching can also be tuned in order to minimize the alterations of the original 

records. 

Additional important features of the code are the following: 

 Selection and spectral matching of EGMs in two perpendicular horizontal directions and the vertical 

direction; 

 Optional tuning of PGA in spectrally-matched signals, for those engineering applications sensitive to 

PGA (such as liquefaction triggering) to be performed with reduced dispersion; 

 Controlled variability in the matching phase under the desired tolerance, to better constrain the 

variability of numerical results (such as in the derivation of numerical fragility functions); 

 Calculations and reporting of some selected EGM intensity parameters. 

The S&M procedure consists of two main phases (Figure 1): (i) Selection (S) and (ii) Spectral matching (M). 

                                                           
1 S&M is a MATLAB application. The current version is Beta v1.0, published on July 2024, accessible from 

the link: https://seismograph.me/s&m. 

 

https://seismograph.me/s&m
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Figure 1. Flowchart of S&M code 

 

 Selection phase: Selection of N records approaching the target spectrum within a given tolerance 

(Figure 2, left). Unlike other approaches based on the overall spectral shape similarity, in S&M a 

more flexible approach is followed based on six controlling criteria for which the User may adjust 

the weights to comply with the project requirements. The corresponding perpendicular horizontal 

components (Figure 2, right) and the vertical components are also extracted. 
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Figure 2 Left: selection of the best graded 20 unscaled records approaching a target spectrum (red line). Right: corresponding 
selection of the perpendicular horizontal component. In this case, due to the high amplitude of the target spectrum, the average of 
the selected spectra is significantly lower than target. Obviously, agreement is worse for the perpendicular H component. 

 

 Matching phase: Once N unscaled records are selected, and if required by the User (for example if 

the average spectral accelerations is distant from target), they undergo a spectral matching 

procedure by iterative scaling in the frequency domain until the response spectrum is approached 

within a given tolerance (Figure 3, Figure 4).  

 

 

 
 

 

 

 
 

 

Figure 3. Effect of spectral matching on the horizontal (top: EW component; bottom: NS component) ground motions recorded at 
NRC station during the M6.5 30 October 2016 earthquake both in terms of acceleration, velocity and displacement time histories 
(left) and in terms of acceleration response spectra (right).  
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Figure 4. Response spectra of the selected ground motions of Figure 1, after spectral matching. 
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2. Background of Selection and Matching phases 
 

The Selection phase consists of the following steps: 

 

o EGMs are extracted from the selected database according to maximum moment magnitude 

defined by the User2.  

o All records are evaluated according to the average (              ) and to the maximum 

(              ) spectral acceleration error thresholds defined by the user:  

 

         
 

 
∑|

                            

               
|

 

   

                 

            |
                            

               
|                 

 

o Each record i satisfying the previous conditions is scored (sij) based on the following criteria 

(Cj) 

 C1: Average spectral compatibility on the entire period range; 

 C2: Maximum spectral deviation on the entire period range; 

 C3: Spectral compatibility within the desired period range (T1min<T<T1max)
3; 

 C4: Spectral compatibility within the remaining period range (T > T1max); 

 C5: Site class dependency4; 

 C6: Closeness to target PGA. 

Considering each criterion, records are sorted from best to worst and scored as 1 (best) to 

100 (worst). Hence, EGMs have a score of sij for each ith ground-motion and jth criterion. 

 

o User-defined weight of each criterion (wj) is combined with the corresponding score sij for 

each EGM and summed up to obtain the cumulative score (Si). 

 

   ∑     

 

   

 

The N best performing EGMs (i.e., the records with the lowest total score Si) are selected, 

after check that in the selected set there is no pair of horizontal components corresponding 

to the same event and same station. 

After the Selection phase, that provides a set of unscaled records, the S&M user may decide to enter the 

Matching phase, where records are iteratively scaled in the frequency domain so that their response 

spectrum better approaches the target one. 

                                                           
2
 It is noted that user defines the Mmax according to the maximum expected earthquake within the seismotectonic 

context of the area under study. For the entire Italian territory, Mmax = 7.25 is reasonable. 
3
 T1min and T1max may be defined based on short period range for more generic applications. For more specific 

applications, they may be defined based on the first vibration period of the structure under consideration, as well. 
4
 In S&M, the selection may be made strictly site-class specific (such as Eurocode 8 Site Class A records for target 

spectrum compatible with hazard levels computed at rock or closely site-class specific, in which one class stiffer and 
softer records are also allowed (such as Site Class A and B for rock spectrum-compatible motions). In such case, the 
code favors the actual site records over the vicinity ones. 
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The spectral matching procedure of each record of the selection consists of the following steps, for k=1....M 

iterations (typically, M=5 iterations are sufficient): 

1. The acceleration response spectrum of the accelerogram Sacc,k(Tm) is computed (of the unscaled record 

if k=1, of the modified accelerogram for k>1) for a set of periods Tm; 

2. The response spectral ratio Rk (Tm) = Sacc,target (Tm) / Sacc,k (Tm) is calculated; 

3. The Fourier amplitude spectrum |FAS|k is computed and multiplied in the frequency domain by Rk at 

discrete frequencies fk=1/Tm. Intermediate frequencies between fk and fk+1 (or fk-1) are linearly 

interpolated; 

4. The phase of the Fourier transform is kept unchanged; 

5. The inverse Fourier transform is computed and the modified accelerogram is produced for Step 1 of 

the k+1 iteration. 
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3. Getting Started 

3.1 Installation 
S&M is a compiled MATLAB application that uses the MATLAB Runtime. The MATLAB Runtime is a 

standalone set of shared libraries that enables the execution of compiled MATLAB applications or 

components on computers that do not have MATLAB installed. 

The MATLAB Runtime is version-specific. User must run application with the version of the MATLAB 

Runtime associated with the version of MATLAB Compiler with which it was created. In this case, since the 

S&M is compiled using version 9.11 (R2021b) of MATLAB Compiler™, users who do not have MATLAB 

R2021b installed must have version 9.11 of the MATLAB Runtime installed. (Available for downloading from 

the Mathworks website: http://www.mathworks.com/products/compiler/mcr). 

 

3.2 Workflow 
After launching the software, the first step is to create a new project. User should assign a unique name 

which also will be used as the name of the project folder. The next step is to define the target spectrum. It 

is required in both selection and match phases. At the third step, user has two options: 

1. To select accelerograms from a dataset (Online or User-defined) 

2. To skip the selection phase and directly import his own accelerograms into the software (in order 

to use the spectral matching module) 

When the selected (or imported) accelerograms are available, user can go to final step and apply the 

spectral matching procedure. 

It is worth noting that in any step, user can review and export available output data from the Export 

section. 

 

3.3 Output 
The results are presented in terms of time series and images of elastic acceleration response spectra. 

Results are given for both horizontal and vertical directions. It is important to note that the selection is 

made by the code based on the best candidates for the primary horizontal direction, after that there is no 

selection made for the perpendicular or vertical direction, instead they are directly taken as the 

corresponding component of the motion under consideration. 

The final results are stored in the project folder, in which user may find the flat files, figures, ground motion 

parameters and also three subfolders named output_H15, output_H26 and output_V7 containing two 

column acceleration time history of the selected or frequency-scaled signals (format: first column is time in 

seconds, second column is acceleration in g’s). 

  

                                                           
5
 H1: primary horizontal component, for which the selection is carried out 

6
 H2: secondary horizontal component, which is the perpendicular one which is used in the selection phase  

7
 V: vertical component 

http://www.mathworks.com/products/compiler/mcr
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4. Example of application 
 

To demonstrate software’s application, let us consider an example of selecting 7 ground motions using a 

sample target spectrum. As the first step, we need to lunch the software and create a new project: 

 

 

1. Click on “New” button to open Project Settings window. 

2. In the Name text box, enter an appropriate name for the project. This name will also be used for 

the project folder. 

3. Click on “OK”. 

 

 

Name and address of the project folder are displayed in the Project Tab. You can click on “Open Folder” 

button to open the project folder in the windows explorer. 
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Next step is to define the target spectrum: 

 

 

1. Go to Target Spectrum Tab and click on “Define” button. 

2. You can load spectrum from a text file (H or H/V buttons). In this example, we are using the built-in 

spectrum tool. Select the “Eurocode 8” and then click on “Define” button. 

3. Leave settings as displayed in the figure and click on “OK”. 

 

The site class definition used to define the target spectrum and the dataset should be consistent. For 

example, if you are using EC8 code spectrum with SIMBAD dataset, No modification is needed and you can 

leave the “Site Classification Scheme” option to “From Dataset”. But for using EC8 code spectrum with 

NGA-West2 dataset you need to use Eurocode 8 Site class definition. As you can see in the following figure, 

Site class C in NGAWest2 dataset (NEHRP Definition) almost corresponds to Site class B according to 

Eurocode definition. 
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In this example we will be using NGAWest2 dataset. Therefore we need to modify the site class definition: 

 

 

1. Select the “User-defined” option and then click on “Set” button. 

2. Select the “Eurocode 8” option from the listbox. 

3. Click on “OK”. 

 

Note: In the latest version, a new feature is introduced that automatically checks for the consistency of site 

class definition and applies required settings. 

 

Finally, you need to click on “OK” button (in the Target Spectrum window) and return to the main window:  
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Now go to the third tab: Select / Import.  

 

 

1. Click on “Load Dataset” button. Make sure that the “Online” option is selected. 

2. Select the “NGAWest2” from the listbox. 

3. Click on “OK”. 

 

Once the dataset is defined, the “Select” button will be enabled and you can open the Accelerogram 

Selection window. 
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In the first tab (Inputs) you can see the selected dataset and the target spectrum. click on “Info” button to 

see additional details for the selected dataset. Note that the the site classification is “converted” to EC8. 

 

 

 

Modify the input parameters as displayed in the following image, and then click on the “Search” button. In 

this example we are using the “SRSS” of the horizontal records as the spectral ordinates. Once the process 

is finished, a list of selected accelerograms is displayed in the table which is sorted acording to best score.  
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You can add or remove some accelerograms from the list. Click on “Modify Search” button. In the new 

window, simply enable or disable the checkbox to include or exclude each accelerogram from the list. 

Finally, click on “OK” button to return to the Accelerogram Selection window. 

 

 

 

From the Accelerogram Selection window, you can also click on “Selection Details” to display more 

information on the selected accelerograms in a table format as well as a Magnitude-distance plot. Note 

that the best match is acheived by the lowest weighted score. However in the graph, best match 

accelerograms are identified by a larger circle with a darker green color: 
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When you are satisfied with the selection list, click on “OK” button and wait until the accelerograms are 

downloaded: 

 

Once the selection phase is complete, list of selected accelerograms are displayed in the main window. You 

can use tools available in “Review” panel to display time histories and response spectra for all or individual 

accelerograms. As you can see in the following figure, the individual components (in this case H1) don’t 

completely match to the target spectrum. This is because the SRSS spectral ordinate was used in the 

selection phase. To display the SRSS spectra, select “Display SRSS Spectra” from the Tools menu and then 

choose the SRSS from the list. 

 

 

  

In order to display RotD plots, you need to calculate data first. From menu bar choose: Edit > Run. 

 



17 
 

The Final step is to apply spectral matching to the selected accelerograms. Go to the Match tab and click on 

“Match” button to open the Spectral Matching window. Set the desired inputs and click on “Match” 

button. When the process is finished, review the results and finally click on “OK”. 

 

 

 

To save any figure displayed in the software, just right-click on the corresponding axes and select the “Copy 

Figure” option. Figure is detached into a new window and then you can save it from: File > Save. 
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In case you want to save image in PNG format, simply use the Quick save panel:  

 

 

   

 

 

 When display popup-menu is set to Selected or Matched Records:  

o If Current Plot selected: Spectral graph + time histories for the currently selected 

accelerogram is saved.  

o If All Plots selected: Spectral graphs + time histories for all accelerograms are saved.  

 

 When display popup-menu is set to Average Records:  

o If Current Plot selected: Average Spectral graph for the currently selected 

accelerogram is saved.  

o If All Plots selected: All Average Spectral graphs (Sa & Sd) for the 3 components (H1, H2 

and H3) are saved.  

 

 

 

 



19 
 

Downloaded (also matched) accelerograms are available in project folder. To export flat files, go to Export 

Tab and click on “Export”. In the Export window you can review output data by selecting each one from the 

available list boxes. To export data: 

1. Mark the outputs you need to export 

2. Click on the “Export” button to export the selected outputs (in .xlsx format) 
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5. User Reference 

5.1 Main Window 
  

 

1. Main Toolbar, including the following tools: 

1. New: to create a new project 

2. Export: to open export window and save output data 

3. Zoom In tool 

4. Zoom out tool 

5. Pan tool 

6. Datacursormode (enables selecting points on the plot and opens a data tip displaying its 

coordinates) 

7. Display Legend: to display or hide the legend 

 

2. Main Tab Panels, including: 

1. Project: to create a new project and access to the project folder 

2. Target Spectrum: to define the target spectrum 

3. Select/Import: to import accelerograms from file / or select accelerograms from available 

datasets 

4. Match: to apply the spectral matching 

5. Export: to display and export output data 

 

3. Selected accelerograms are displayed in this listbox. Depending on what options are set from the 

Review panel (4 to 8), spectral acceleration (or displacement) for selected (or matched) accelerograms 

(as well as its time histories) can be displayed. 

 

4. Select appropriate option to: 

1. Display time histories and response spectra for selected accelerograms.  

2. Display time histories and response spectra for matched accelerograms.  

3. Display the average spectra for both selected and matched records. 
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5. Press this button to plot all spectra (selected or matched) in the same graph. 

 

6. Use this option to switch between acceleration (Sa) and displacement (Sd) response spectra. 

 

7. Use this option to switch between three different components of the accelerogram (Horizontal-1, 

Horizontal-2, Vertical) 

 

8. Enable the appropriate checkbox to use logarithmic scale for the x or y axis of the graph. 

 

9. Use this option to quickly capture and save various screenshots, including: 
 

 If display popup-menu is set to Selected or Matched Records: Spectral graphs and time 

histories for the currently selected accelerogram are saved. (Enable “All” button, save plots for 

all accelerograms) 

 If display popup-menu is set to Average Records: Spectral graphs for the 3 components and 

both Sa and Sd are saved. (time histories are not included) 

 

10. The Spectrum context menu (right click on the axes area while no tools from the toolbars is selected) 
 

 New Project: to create a new project. 

 Open Project Folder: to open and explore the project folder 

 Define Target Spectrum: to open the Target Spectrum window. 

 Load Dataset: to load the dataset from which accelerograms are selected. 

 Select...: to access the Accelerogram Selection window. 

 Import Accelerogram: to load accelerograms into the software. 

 Match...: to access the Spectral Matching window. 

 Export Data: to review and export output data. 

 Copy Figure: to make a copy of current axes into a new window. 

 Display Table: to display X and Y data for the current axes in a table. By displaying the table, its 

data is automatically copied into th clipboard. (Use Ctrl+V to paste data in a text file) 

 

11. The Time Histories axes context menu (you need to right click on the axes area) 

 

 Display Table: to display X and Y data for the current axes in a table. By displaying the table, its 

data is automatically copied into th clipboard. (Use Ctrl+V to paste data in a text file) 

 

12. Hint Bar: a short description of the selected tab is displayed here. 

 

13. This Status Bar is aimed to illustrate the overall software’s workflow and provide a step by step guide to 

user. After completing each step, it turns to green and the next step is highlighted in blue. 

 

 
 

Status Bar description: a new Project has been created successfully and next step is to define the 

Target Spectrum 
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5.1.1 Project Tab 
 

 

1. Click on “New” button to create a new project. Enter a name for the project and then click on “OK” 

button. 

2. Use this button to open the project folder and explore the output files. 

3. Project name is displayed here. 

4. Project folder location is displayed here. 

 

5.1.2 Target Spectrum Tab 
 

 

1. Click on “Define” button to open the Target Spectrum window.  

2. After defining the target spectrum, its summary information is displayed here. 
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5.1.3 Select / Import Tab 
 

 

 If you want to select appropriate set of accelerograms from available datasets, you need to choose 

“Select from Dataset” option. 

 

1. Click on “Load Dataset” button to open the Select Dataset window.  

2. After selecting the Dataset, the “Select” button is enabled and you can access to the Accelerogram 

Selection Window. 

3. Selected Dataset is displayed here. 

 

 

 If you already have the accelerograms files, simply choose “Import from File” option. 

 

1. Click on “Import” button to open the Import window.  
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5.1.4 Match Tab 
 

 

1. Click on “Match” button to open the Spectral Matching window.  

2. After the matching, summary information is displayed here. 

 

 

5.1.5 Export Tab 
 

 

1. Click on “Export Data” button to open the Export window.  
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5.2 Menu Bar 
 

 

File 

1. Create a new project 

2. Export output data 

3. Exit the program 

 

 

Tools 

1. Display Spectral ordinates (SRSS, Geomean, RotD50, 
RotD100) for selected (and matched) accelerograms 

 

 

Help 

1. Manually check for new updates 
 
(normally software will run this option on startup, and if 
there is a new version it will prompt user with the update 
manager message, including release notes and the 
download link). 
 

2. Display software’s  version and information  
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5.3 Target Spectrum Window 
 

  

 Define input spectrum as User-Defined or EC8 spectrum: 

 

1. Select the site class, which is necessary to pick the recordings from dataset corresponding to the 

site class of interest (only for user-defined target spectrum). 

2. Use "H" button to load user-defined horizontal target spectrum from a 2-columns text file (period-

acceleration). Use "H/V" button to load both horizontal and vertical target spectrum from a 3-

columns text file (period - acceleration_H - acceleration_V) 

3. Calculate elastic response spectrum in terms of spectral acceleration and spectral displacement in 

the horizontal or vertical direction according to EN1998-1. 

4. Calculate design response spectrum (horizontal or vertical spectral acceleration and spectral 

displacement) according to ASCE 7-16. 

5. If the site class definition for the target spectrum is the same as it is defined for the dataset, simply 

leave this option to “From Dataset”. Otherwise, you need to define site classification that matches 

to that of the target spectrum. 

6. Click on this button to access the Site Classification Window. 

7. To display X and Y data of each axes in a table, right click on the axes area and select Display Table. 

By displaying the table, its data is automatically copied into th clipboard. (Use Ctrl+V to paste data 

in a text file) 
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5.3.1 Eurocode 8 Spectrum 

 

1. Select the shape of spectrum: 

 Type 1 spectra correspond to typical high seismicity hazard. 

 Low seismicity Type 2 spectra are recommended when the earthquakes that contribute 

most to the seismic hazard have a surface-wave magnitude, Ms, not greater than 5.5. 

2. Enter the reference peak ground acceleration (ag) on type A ground (rock) 

3. Select the site class (A, B, C, D, E) according to Eurocode 8 definition. 

4. Enable this checkbox to calculate vertical spectrum. 

 

5.3.2 ASCE 7-16 Spectrum 

 

1. Enter the mapped MCER, 5% damped, spectral response acceleration parameter at short periods 

(SS) as defined in Sections 11.4.2, 11.4.4 (ASCE 7-16). 

2. Enter the mapped MCER, 5% damped, spectral response acceleration parameter at a period of 1s 

(S1) as defined in Sections 11.4.2, 11.4.4 (ASCE 7-16). 

3. Enter the long-period transition period as defined in Section 11.4.6 (ASCE 7-16). 

4. Select the site class (A, B, C, D, E) according to ASCE 7-16 definition. 

5. Enable this checkbox to calculate vertical spectrum. 
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5.3.3 Site Classification 

  

1. You can select pre-defined Site Classification schemes from this list. 

2. If the “User” is selected from the list, you can manually define the VS30 boundaries in these 

textboxes. 

 

5.4 Select Dataset Window 

  

Online Dataset User Dataset 
  

 If you want to use any of available online datasets, simply choose the “Online” option, select the 

desired dataset from the list and then click on “OK” (multiple selection is allowed byy holding Ctrl 

Key). Enable “Select All” checkbox to search within all available datasets. 

 

 If you have already compiled a user-defined dataset, choose the “User” option and then use the 

“Load File” button to browse and select the dataset file. 
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5.5 Accelerogram Selection Window   

 

 

1. Main Tab Panels, including: 

1. Input: to set the main criteria for selection process. 

2. Site Class: to define how records are filtered by soil type 

3. Period Ranges: to define different period ranges over which the weights can be applied. 

4. Weights: to assign desired weights to control how accelerograms are scored in the 

selection process 

5. Tolerances: to define different upper and lower tolerances. 

2. Selected accelerograms are listed in this table. 

3. Click on this button to start the search process. 

4. You can modify the final selection list by adding or removing the records. Use this button to access 

the Modify Window and apply the appropriate modifications. 

5. Use this button to display the calculated score and other information of the selected accelerograms 

in a table, as well as the Magnitude-Distance graph. 
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6. Click on this button to display the response spectra for all selected accelerograms. 

7. Use this button to display only the average response spectrum. 

8. Using this option, you can adjust the Y axis limit to upper limit of the target spectrum in order to 

completely fill the graphs with the target spectrm. 

9. Using these three buttons you can modify the X axis limit of the graphs in order to focus on primary 

or secondary period ranges. 

10. Use this option to switch between three different components of the accelerogram (Horizontal-1, 

Horizontal-2, Vertical). If spectral ordinate is set to SRSS (or GeoMean), a new SRSS radiobutton will 

also be displayed. 

11. Enable the appropriate checkbox to use logarithmic scale for the x or y axis of the graph. 

12. To make a copy of current axes into a new window, right click on the axes area and select Copy 

Figure. To set Y limit of the both graphs to upper limit of the target spectrum, simply select Adjust 

Y limit from the same right click menu. 
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5.5.1 Input Tab 
 

 

 

Inputs Tab Dataset Info window 

 

1. Click on this button to access the Dataset Info window.   

2. Enter the number of accelerograms wanted in the final set. 

3. Using this option, restrict the maximum number of records per event in the final selection list. 

4. Select the spectral ordinate for which the mistmatchs are calculated: 

 Vertical: search within the vertical conponent of ground motions. 

 Horizontal: search within both horizontal conponents to find best match (default). 

 SRSS: SRSS spectra of horizontal ground motions are calculated and compared to target 

spectrum. 

 GeoMean: Geometric mean spectra of horizontal components are used to find best match. 

 Pulse Orientation: The pulse duration, reported in the flatfile, corresponds to the rotated 
accelerogram along the azimuth for which the pulse is detected. Using this option, 
response spectra of rotated accelerograms are used to find best match. 
 
In this mode, rotated accelerograms are calculated and stored in the “Pulse_Orientation” 
folder inside the project folder. Ground motion parameters and the flatfile for the pulse 
component are also exported automatically. 
 

5. Control the epicentral distance range by setting the Distance Range [Rmin, Rmax]. 

6. Set the Magnitude Range [Mmin, Mmax], to filter out the signals corresponding to unwanted 

magnitudes (such as filtering out too large magnitudes considering the seismogenic framework of 

the study area) 

You can define [0, 0] for the entire range. 

7. Set the average permissible mismatch in spectra. Average permissible spectral mismatch is the 

mean disagreement between target and event response spectra considering whole range of 
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vibration periods. Smaller values mean better agreement in general. 40% is default and a 

reasonable value. 

8. Set the maxima of permissible mismatch in spectra. Maximum permissible mismatch is the 

maximum allowable disagreement between target and event response spectrum. 80% is default. 

9. Restrict the pulse characteristics of the searched record by selecting the appropriate option: 1) Any 

record, 2) Only pulse-like records, and 3) No pulse-like records. 

10. If previous option is set to “Any record”, then this option can be used to request percentage of the 

puls-like records in the selection. 

11. If pulse-like records are included in the selection, then this option can be used to set the desired 

range for the pulse duration. 

 

  

5.5.2 Site Class Tab 
 

  

1. Define site class (A, B, C, D, E). Site class definitions are necessary to only pick the records from the 

dataset corresponding to the site class of interest. 

Note: this option can be edited from the Target Spectrum window. 

2. Define how you want to filter records (Strict, Close, Any site class) by site class criterion while 

searching for candidate accelerograms 

 Any: no filtering is applied.  

 Strict: if you specifically want the recorded signals corresponding to the target site class. 

 Close: if you might also select the records with one site class in vicinity (e.g. if the site class 

is set to "B", records with A, B and C are also included in the searching process) 
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5.5.3 Period Ranges Tab 

 

1. Set the period range in which average and maximum mismatch values are calculated  

2. Define the primary period range under consideration. One may constrain it according to the 

fundamental period of vibration range, short period content, long period content, etc. 

3. Define the secondary period range of interest. It defines the rest of the vibration period range. This 

option is of particular use when the target structural stock has relatively short natural vibration 

period, while one would like to keep long period content in agreement with target demand. 

4. Enable this checkbox to search for records with an average spectrum that matches target spectrum 

only at the period of interest. 

 

5.5.4 Weights Tab 
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1. Weight assigned to average mismatch between the calculated and target acceleration spectral 

ordinates within the total period range. 

2. Weight assigned to average mismatch between the calculated and target acceleration spectral 

ordinates within short period content. 

3. Weight assigned to average mismatch between the calculated and target acceleration spectral 

ordinates within long period content. 

4. Weight assigned to maximum mismatch between the calculated and target acceleration spectral 

ordinates. 

5. Weight assigned to the magnitude range. 

6. Weight assigned to the site class under consideration. 

7. Weight assigned solely to PGA. 

8. Reset all weights to default value. 

 

Note: If you set 1 for one of the weights, the other weights will automatically change to 0. 

 

 

5.5.5 Tolerances Tab 
 

 

1. Define the upper tolerance for the target spectrum. 

2. Define the lower tolerance for the target spectrum. 

Note: The above option is just used to provide a visual check on the graph.  

3. Using this button you can check if the current average spectrum (H1, H2 or V) is inside the defined 

upper and lower tolerances.  
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5.5.6 Modify Selection Window 
 

 

1. A preview of acceleration time history for the selected record is displayed here. 

2. To add (or remove) any accelerogram from the list, simply enable (or disable) its checkbox from the 

table. 

3. Use this option to switch between three different components of the accelerogram (Horizontal-1, 

Horizontal-2, Vertical and SRSS/GM, if available) 

4. Enable the appropriate checkbox to use logarithmic scale for the x or y axis of the graph. 

5. Use this toggle button to switch between display of all or average response spectra. 

6. Use this button to cancel all modifications. 
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5.6 Import Window 

 

 Using this window you can load accelerograms into the program. It is also possible to create a 

dataset from the loaded files. 

 

1. Use this button to remove all loaded files and clear the table. 

2. Use this button to create a dataset from the current table and save the *.mat file. 

3. Using this option you can load general (*.txt or .AT2) files. S&M can automatically determine 
the keywords by which the three components are separated (H1, H2 and V). Detected 
keywords are displayed in the Component Window for user to review. There are also two other 
options in “Pre-defined” tab in order to load files that belongs to the SIMBAD and K-Net 
databases. (in this case, the three components are automatically separated without 
determining the component keywords) 

 

4. Enable this option to keep currently loaded accelerograms in the table. Otherwise, current data 

will be replaced. 

5. Number of loaded accelerograms is reported in this section. 
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5.7 Match Window 
 

 

1. Main Tab Panels, including: 

 Input: to set the main inputs for spectral matching process. 

 Options: to provide additional settings. 

2. Click on this button to start the spectral matching process. 

3. Use this button to display the response spectra for all selected accelerograms. 

4. Use this button to display only the average response spectrum. 

5. Use this option to switch between three different components of the accelerogram (Horizontal-1, 

Horizontal-2, Vertical) 

6. To make a copy of current axes into a new window, right click on the axes area and select Copy 

Figure. 
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5.7.1 Input Tab 

 

1. This parameter controls the number of iterations to be made in the spectral matching phase. 

(Suggested to be maximum 5, recommended values: 2-3) 

2. Set the minimum and maximum period that you want to be scaled in frequency domain. (The 

spectral matching is only carried out within this range) 

3. Define the Upper and Lower acceptable tolerances defining the spectral variability of matched 

signals. (Range=20-40%). To have less modified accelerations, users are advised to define it around 

not less than 20%. 

 

5.7.2 Options Tab 
 

 

1. If you want to have very close PGA agreement with the target value, enable this checkbox. 

2. If enabled, the spectral matching is also applied to the perpendicular horizontal component. (H2) 

3. If enabled, the spectral matching is also applied to the vertical component. (V) 

4. This option is to randomize the target spectrum. Spectral matching phase often ends up with tight 

spectral agreement between target and iterated event spectrum. With this option enabled, the 

target spectrum is slightly randomized (for N times with N=number of records desired in a set). This 

way, the resulting matched event spectra always show aleatory spectral variability around the 

target. 

5. Use this option if you need to match SRSS of the records to the target spectrum (otherwise, every 

single record will be matched to the target spectrum and as the result, SRSS of the selection to falls 

above the target spectrum). 
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5.8 Export Window 
 

 

1. Mark the outputs you need to export from this section. 

2. Click on this button to export the selected outputs (in .xlsx format) 
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5.9 Display SRSS Window 
 

 

1. Choose the appropriate option to display the response spectra for the selected (or matched) 

records. 

2. Select the desired Spectral ordinate from this list to display the response spectra. for RotD option, 

you need to calculate data first. (from menu bar choose: Edit > Run) 

 


